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本アプリケーション ノート (AN94020) では、ARM
®
 Cortex™-M0ベースのプログラマブル ラジオ オン チップに BLE無線機能を

搭載した製品「PRoC BLE」についてご紹介いたします。PRoC BLE ソリューションおよび開発ツールを探求できる他、PSoC 

Creator™という PRoC BLE 用の開発ツールを使用して初めて自分の BLE プロジェクトをビルドする際に有用なご案内も提供 

いたします。さらに、PRoC BLE に関わる深い知識を迅速に取得できるように提供するリソースへのアクセス方法も記述しており

ます。 
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1 はじめに 

PRoC BLEは、CapSense
®、12ビットアナログ-デジタル変換器 (ADC) 、4個のタイマー／カウンタ／PWM (TCPWM) 、4個の 

追加 8/16ビット PWM、36本の GPIO、2個のシリアル通信ブロック (SCB) 、液晶ディスプレイ (LCD) ドライバー、および IC間 

サウンド (I2S) を搭載する 32 ビットの 48MHz ARM Cortex-M0 BLE チップです。これはヒューマン インターフェース デバイス 

(HID) 、リモコン、玩具、ビーコンおよびワイヤレス充電器に、完全で柔軟なプログラマブルなソリューションを提供します。 

さらに、PRoC BLEといった低コストで簡単な手段を利用することで BLE接続をどのシステムにも追加できます。  

PRoC BLEは、Bluetooth 4.1仕様に適合する無償の BLEプロトコル スタック (コントローラーとホスト) からなり、Bluetooth 

Special Interest Group (BT SIG) 採択済みプロファイルをすべて含む (仕様リビジョンおよびプロファイルの将来の変更に 

対応できるようにロードマップも用意した) BLEプロファイルのパッケージソフトで提供されます。 

PRoC BLEは、時計用水晶発振器 (WCO) 有効の 1.3µAのディープスリープ モード；SRAM内容、プログラマブルなロジック
および割り込みによるウェイクアップ機能を維持する 150nA のハイバネート モード；および GPIO 割り込みによるウェイク 

アップ能力を維持する 60nAのストップ モードといった低電力モードが整備されます。 

PRoC BLE 内の CapSense という容量タッチ センシング特長は、ボタン、スライダー、トラック パッドや近接センサーなどの
多種多様なセンサー タイプを提供します。このチップの高い信号対ノイズ比および耐水性により誤タッチを回避できます。 

PRoC BLEの他、サイプレスは、BLE無線、プログラム可能なアナログとデジタル周辺機能、メモリ、および ARM Cortex-M0

マイクロコントローラーを単一のチップに集積したプログラマブル組み込みシステムオンチップ「PSoC 4 BLE」製品も提供します。
詳細については、AN91267 - Getting Started with PSoC

®
 4 BLEアプリケーション ノートをご覧ください。サイプレスの BLE

デバイス ファミリ内の各製品間の比較については、付録 A: BLEデバイス ファミリの比較をご覧ください。 

2 PSoC リソース 

サイプレスは、www.cypress.com に大量のデータを掲載しており、ユーザーがデザインに適切な PRoC/PSoC デバイスを選
択し、デザインに迅速かつ効率的に統合する手助けをしています。サイプレスの PRoC/PSoC製品ファミリの初心者のお客様は、
付録 B: サイプレスの用語に記載する一般的に使用する用語一覧をご覧くださるようお勧めします。リソースの総合リスト 

については、「KBA86521, How to Design with PSoC 3, PSoC 4, and PSoC 5LP」をご参照ください。  

以下は PRoC BLEのリソースの要約です。 

 概要: PSoCポートフォリオ、PRoCポートフォリオ 

 製品セレクター: PSoC 1、PSoC 3、PSoC 4または PSoC 5LP。さらに、PSoC Creatorにはデバイス選択ツールが

含まれています。 

 データシート: CYBL10X6Xと CYBL10X7X デバイス ファミリ向けの電気的仕様を説明し提供します。 

 アプリケーション ノートおよびサンプル コード: 基本レベルから上級レベルまでの幅広いトピックを提供します。多くの

アプリケーション ノートはサンプル コードを含んでいます。PSoC Creatorは追加のサンプル コードを提供します。詳

細は、「サンプル コード」をご参照ください。 

 テクニカル リファレンス マニュアル (TRM): 各 PRoC BLEデバイス ファミリのアーキテクチャとレジスタについて詳

細に説明します。 

 CapSenseデザイン ガイド: PRoC BLEファミリのデバイスを使用して静電容量タッチセンシング アプリケーションを

設計する方法について説明します。 

 開発ツール 

 CY8CKIT-042-BLE Bluetooth Low Energy (BLE) Pioneer Kit: 使いやすくて安価な BLE向けのプラットフォーム

です。このキットは、Arduino™準拠シールドおよび Digilent® Pmod™ドーターカード用コネクタを搭載します。 

 Windows、iOS、および Android 用 CySmart BLE Host Emulation Tool: ご使用の BLE ペリフェラル アプリケー 

ションをテストおよびデバッグするための使い勝手の良い GUIです。 

その概要については、付録 C: サイプレス BLE開発ツールをご覧ください。 

http://www.cypress.com/?rID=102504
http://www.cypress.com/
http://www.cypress.com/?id=4&rID=77024&source=an79953
http://www.cypress.com/psoc
http://www.cypress.com/procble/
http://www.cypress.com/?id=1573&source=an79953
http://www.cypress.com/?id=5041&source=an79953
http://www.cypress.com/?id=4976&source=an79953
http://www.cypress.com/?id=5044&source=an79953
http://www.cypress.com/psoccreator/
http://www.cypress.com/?rID=99422&source=procble
http://www.cypress.com/?rID=113366
http://www.cypress.com/?app=search&searchType=advanced&keyword=&rtID=76&id=5258&applicationID=0&l=0
http://www.cypress.com/?app=search&searchType=advanced&keyword=&rtID=117&id=5302&applicationID=0&l=0
http://www.cypress.com/?rID=78578
http://www.cypress.com/?rID=78578
http://www.cypress.com/go/cy8ckit-042-ble
http://www.cypress.com/cysmart
https://itunes.apple.com/us/app/cysmart/id928939093?mt=8
https://play.google.com/store/apps/details?id=com.cypress.cysmart&hl=en
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 テクニカル サポート 

    よくある質問 (FAQ): サイプレスの BLEエコシステムについて詳細に説明します。 

    BLE フォーラム: PSoC 4 BLE と PRoC BLE フォーラムをご覧になって、ご質問が既に他の開発者によって解

答されているか確認して頂けます。 

     サイプレス サポート: まだ困っていますか？サイプレスのサポート ページを訪れられ、テクニカル サポート ケー

スを作られるか、またはお近くの代理店までお問い合わせください。米国のお客様は、弊社フリーダイヤル (+1-

800-541-4736) までお電話いただければ、弊社のテクニカル サポート チームより通話でご対応いたします。プ

ロンプト上のオプション「8」を選択してください。 

2.1 PSoC Creator 

PSoC Creatorは無償のWindowsベースの統合設計環境 (IDE) です。このツールにより、お客様は PSoC 4 BLE、PRoC 

BLE を基にして、ハードウェアとファームウェアを同時に設計できます。図 1 に示すように、PSoC Creator を使用すれば、以下の

ことを実現できます。 

1. コンポーネントをドラッグ アンド ドロップして、メイン デザイン ワークスペースでハードウェア システム デザインを構築 

2. アプリケーションのファームウェアと PRoCハードウェアを同時に設計 

3. コンフィギュレーション ツールを用いて、コンポーネントを構成 

4. 100以上のコンポーネントを含むライブラリを探索 

5. コンポーネント データシートを確認 

図 1. PSoC Creatorの回路図エントリとコンポーネント 

Drag and Drop 

Components

Configure Components

Open DatasheetDevelop Firmware

 

 

http://www.cypress.com/?rID=102799
http://www.cypress.com/?app=forum&id=5283&rID=102842
http://www.cypress.com/?app=forum&id=5283&rID=102842
http://www.cypress.com/?app=forum&id=5283&rID=102843
http://www.cypress.com/support
http://www.cypress.com/myaccount/?id=25&source=support
http://www.cypress.com/myaccount/?id=25&source=support
http://www.cypress.com/?id=1062
http://www.cypress.com/psoccreator/
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2.2 PSoC Creatorヘルプ 

PSoC Creatorホームページへアクセスして PSoC Creatorの最新版をダウンロードしインストールしてください。次に、PSoC 

Creatorを起動して、以下の項目を開きます。 

1. Quick Start Guide (クイック スタート ガイド): Help > Documentation > Quick Start Guideを選択します。このガイドは

PSoC Creatorプロジェクトを開発するための基礎知識を提供します。 

2. Simple Component example projects (簡単なコンポーネント サンプル プロジェクト): File > Open > Example 

projects を選択します。これらのサンプル プロジェクトは、PSoC Creator のコンポーネントの設定と使用方法を説明し

ます。 

3. Starter designs (初心者向けの設計): File > New > Project > PSoC 4 Starter Designsを選択します。これらの 

初心者向けの設計は、PSoC 4の独自の機能をデモします。 

4. System Reference Guide (システム リファレンス ガイド): Help > System Reference > System Reference Guide

を選択します。このガイドは、PSoC Creatorが提供するシステム機能を記載し説明します。 

5. Component datasheets (コンポーネント データシート):  コンポーネントを右クリックして「データシートを開く」を選択します。 

6. Document Manager (ドキュメント マネージャー): PSoC Creatorが提供するドキュメント マネージャーにより、ドキュメント 

リソースを容易に検索し、レビューすることができます。Document Manager を開くには、メニューから Help >Document 

Managerを選択します。 

2.3 サンプル コード 

PSoC Creator は多数のサンプル コード プロジェクトを提供しています。これらのプロジェクトは、図 2 に示すように、PSoC 

Creatorのスタート ページからアクセスできます。 

サンプル プロジェクトは、空のページの代わりに完成した設計で開始して設計時間を短縮させることができます。サンプル  

プロジェクトは、PSoC Creator コンポーネントを様々なアプリケーションに使用する方法も示します。図 3 に示すようにサンプル 

コードおよびデータシートが含まれています。 

図 3に示す Find Example Projectダイアログにはいくつかのオプションがあります。 

 アーキテクチャ、デバイス ファミリ (PSoC 4、PSoC 4 BLE、PRoC BLEなど)、カテゴリまたはキーワードに基づいて

サンプル プロジェクトを検索します。 

 Filter Options に基づいて提供されたサンプル プロジェクトのメニューから選択します。図 3 に示すように、 

20 以上の BLE サンプル プロジェクトが提供されています。選択したプロジェクトのデータシートをレビューします 

(Documentation タブ)。 

 選択したプロジェクトのサンプル コードをレビューします。このウィンドウからコードをプロジェクトにコピー アンド ペースト

して、コード開発時間を短縮させることができます。 

さらに、選択に応じて新規プロジェクト (また、必要な場合は新規ワークスペース) を作成することができます。完成した基本的

な設計で開始して設計時間を短縮させます。このように、設計をご開発中のアプリケーションに適合させることが可能になり 

ます。 

http://www.cypress.com/?id=2494&source=an79953
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図 2. PSoC Creatorのサンプル コード 

 

図 3. サンプル プロジェクトおよびサンプル コード 
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3 PRoC BLEの機能 

PRoC BLEは、CPUとメモリ サブシステム、BLEサブシステム、デジタル サブシステム、およびシステム リソースからなる機

能豊富なデバイス ファミリです。図 4 と図 5 にはそれぞれ CYBL10X6X と CYBL10X7X デバイス ファミリの可能な機能を 

示します。 

各機能の簡単な説明については、付録 D: PRoC BLE デバイスをご覧ください。また、詳細な情報については、PRoC BLE 

ファミリ用のデータシート、TRM、およびアプリケーション ノートをご覧ください。 

図 4. PRoC BLEアーキテクチャ (CYBL10X6X) 

 

http://www.cypress.com/?docID=50589
http://www.cypress.com/?app=search&searchType=advanced&keyword=&rtID=117&id=5302&applicationID=0&l=0
http://www.cypress.com/?app=search&searchType=advanced&keyword=&rtID=76&id=5302&applicationID=0&l=0
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図 5. PRoC BLEアーキテクチャ 

(CYBL10X7X)

 

4 BLEの概要 

BLE または Bluetooth SmartTM は、Bluetooth SIG により策定された、低消費電力、短距離、低データ レートの無線通信 

プロトコルです。図 6に示すように、BLEは、低消費電力で小さなデータ チャンクを効率的に転送するために設計された階層

式プロトコル スタックを有するもので、バッテリ式デバイス向けの事実上の無線プロトコルとなります。 

BLEスタックは以下の要素からなります。 

 物理層 (PHY): 2.4GHz RF、データ レートが 1Mbps 

 Link Layer (LL): PHYのタイミングおよびパケット形式を定義する 
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 Host Control Interface (HCI): スタックのハードウェア コントローラー (PHY + LL) の層とファームウェア ホスト層をリンク

する 

 Logical Link Controlおよび Adaptation Protocol (L2CAP): パケット アセンブリ／ディスアセンブリおよびプロトコル マ

ルチプレクサ層として動作する 

 Attribute Protocol (ATT): アプリケーション データの構成とアクセス方法を定義する 

 Security Manager (SM): BLE接続を介した安全なデータ転送を行うためのツールボックス 

 Generic Attribute Profile (GATT): ATT層により定義されたデータにアクセスする方式を定義する 

 Generic Access Profile (GAP): デバイスが BLEリンク マスターかスレーブかを定義し、それに応じた下層を構成するア

プリケーション指向インターフェース 

BLEプロトコルの詳細説明については、付録 E: BLEプロトコルをご参照ください。 

図 6. BLEアーキテクチャ 
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BLE を使用したアプリケーションを開発するには、この複雑なプロトコル スタックの実用的な知識は必要ありません。サイプレス

は、プロトコルの複雑さを簡素化し、構成しやすい GUI ベースの BLE コンポーネントを提供します。BLE を使い始めるにあたって、

以下を理解すれば充分です。 

 BLE接続を確立する手順 

 アプリケーション データ表現と抽象  

 サイプレスの BLEコンポーネント GUIを使用した GAPと GATT層構成のアプリケーションの要件マッピング 

4.1 BLE接続の確立 

BLE Pinoneer Kitとスマートフォンのような 2つのデバイス間の BLE接続を確立するにあたって、以下の 2つのGAPデバイスの

ロールを理解する必要があります。 

 GAP ペリフェラル: 自分の存在を広報し、GAP セントラル デバイスからの接続を許可するデバイスです。心拍数測定機

能を実装する BLE Pioneer Kitが GAPペリフェラル デバイスの一例です。 

 GAP セントラル: GAP ペリフェラルからの広報をスキャンし、それらのペリフェラルとの接続を確立します。心拍数測定 

デバイスに接続するスマートフォンが GAPセントラル デバイスの一例です。  
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セントラル デバイスがペリフェラルとの接続を確立した後、両方のデバイスは BLE接続を介して接続されていると言われます。

接続された BLE 通信では、GATT は、GAP のロールとは関係なく、データの転送元と転送先に基づいて以下の 2 つの 

ロールを定義します。 

 GATT サーバー: データまたは状態情報を格納するデバイスです。GATT クライアントにより構成されると、GATT 

クライアントにデータを送信するか、または自分のローカル状態を変更します。例えば、心拍数測定デバイスは、 

スマートフォン GATTクライアントに心拍数のデータを送信する GATTサーバーです。  

 GATT クライアント: GATT サーバーの状態を構成するか、または GATT サーバーからデータを受信します。 例えば、 

心拍数測定デバイスから心拍数情報を受信するスマートフォンは GATTクライアントです。 

BLE接続が確立された後、GATTクライアントは GATTサーバーに存在するすべてのデータを検出します。データを検出すると、

GATTクライアントは GATTサーバーを構成する、および／または GATTサーバーに対してデータを読み書きすることができ

ます。  

図 7 に、GAPペリフェラル／ GATTサーバーロールとして構成された BLE Pioneer Kitと、GAPセントラル／GATTクライアント 

デバイスとして構成されたスマートフォンとの接続の例を示します。各デバイスでの GAP と GATT ロールの構成は、 

アプリケーションの使用状況と BLE Profile によって定義されます。例えば、心拍数を測定するデバイスは心拍数データを 

公開する GATT サーバーのロールを果たし、GAP ペリフェラル デバイスとして構成されます。一方、心拍数測定デバイス 

から心拍数の情報を読み取るスマートフォーンは GATT クライアントのロールを果たし、GAP セントラル デバイスとして構成

されます。  

図 7. BLEアプリケーションの概要 

 

4.2 GATTデータ形式 

GATTサーバーは、アトリビュート、キャラクタリスティック、およびサービスで BLEデバイスのデータを表示および抽象化します。 

 アトリビュート: ATT/GATT 層の基本的なデータ コンテナであり、一件の個別情報を表します。図 8 に示すように、 

アトリビュートは以下の要素から構成されています。 

 アトリビュート ハンドル: アトリビュートをアドレス指定するために示します。 

 アトリビュート タイプ: Bluetooth SIGが割り当てる 16ビットのUUID (Universally Unique Identifier) であり、アトリビュート

に格納されているものを定義します。 

 アトリビュート バリュー: 実データを格納します。  

 アトリビュート パーミッション: アトリビュートの読み出し／書き込み、およびセキュリティ要件を定義します。  

心拍数測定、バッテリ残量、バッテリ残量単位、およびデバイス名がアトリビュートの例です。 
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GATTサーバーには、「アトリビュート データベース」と呼ばれるファームウェア データベースに格納される数多くのアトリビュー

トが含まれます。 GATTクライアントは、アトリビュート ハンドルを使用して GATTサーバーのアトリビュート データベースから

1つまたは複数のアトリビュートを読み書きします。 

図 8. GATTアトリビュートの例 

Attribute 

Handle
Attribute Type Attribute Value

Attribute 

Permission

2 bytes 2 bytes 0 to 512 bytes

0x0003

0x2A00 

(UUID for 

Device Name)

“Cypress HRM”

Read Only, No 

Authentication, 

No Encryption
Example

Format

 

 キャラクタリスティック: 複数の個別アトリビュートで構成されています。これらのアトリビュートを組み合わせるとシステム

情報や意味のあるデータを形成します。図 9 に示すように、キャラクタリスティックは、1 個のキャラクタリスティック宣言 

アトリビュート、1個のキャラクタリスティック値のアトリビュート、1つまたは複数 (任意) のキャラクタリスティック ディスクリプタ

のアトリビュートで構成されています。「90」のバッテリ残量のアトリビュートと、「%」のバッテリ残量ディスクリプタのアトリ

ビュートを組み合わせると、90%のシステムのバッテリ残量情報を作ります。 

Bluetooth SIG は、ご開発のアプリケーションに有用な定義済みの標準キャラクタリスティック一式を提供します。あるいは

独自のカスタム キャラクタリスティックを定義することもできます。 

図 9. GATTキャラクタリスティックの例 

<<Declaration>>

<<Value>>

<<Descriptor>>

Format

Battery Level 

Characteristic Declaration

Battery Level (90)

Characteristic Presentation 

Format (%)

Example

 

 サービス: デバイスの特定の機能または特長を定義する 1 つまたは複数の関連キャラクタリスティックより構成されます。

図 10に、心拍数測定に関連する情報を説明した 3つのキャラクタリスティックを含む心拍数サービスの例を示します。 

Bluetooth SIG は、BLE デバイスの一般的な機能を実装するための定義済み標準サービス一式を提供しています。 

あるいは標準またはカスタム キャラクタリスティックからなる独自のカスタム サービスを定義することもできます。  

https://developer.bluetooth.org/gatt/characteristics/Pages/CharacteristicsHome.aspx
https://developer.bluetooth.org/gatt/services/Pages/ServicesHome.aspx
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図 10. GATTサービスの例 

Service

Heart Rate Service

Characteristic

Heart Rate Measurement

Characteristic

Body Sensor Location

Characteristic

Heart Rate Control Point

Heart Rate Service

 

4.3 BLEプロファイル 

BLE プロファイルは、プロファイル準拠デバイス間のアプリケーション レベルでの相互運用性を確保するための仕様です。 

特定の最終アプリケーションやユースケースを作成するために、異なる BLE 層のロールと構成、および対応する GATT 

サービスを定義します。例えば、心拍数監視機器を実装したい場合、BLE 心拍数プロファイルは、相互運用可能な心拍数測

定装置を作成するために必要な GAP と GATTのロール、および対応する GATTサービスを定義します。Bluetooth SIGは、

一般的な BLE 最終アプリケーション用の定義済み標準プロファイル一式を提供しています。あるいは標準またはカスタム  

サービスからなる独自のカスタム プロファイルを作成することもできます。 

図 7に示すように、プロファイルは GATT層と同様に、2つのアプリケーション ロールを定義します。 

 センサーまたはサーバー: データを有するアプリケーション 

 コレクターまたはクライアント: データを求めるアプリケーション 

図 11に、BLEデバイスにおけるデータ抽象化とデータ階層の概要を示します。 

図 11. BLEデータ階層* 

 

*Bluetooth SIGにより提供された無料イメージ 

4.4 BLE コンポーネント 

PSoC Creator の BLEコンポーネントは、BLEプロトコルの複雑さをシンプルで使いやすい GUI と数個の APIで簡素化します。

BLEコンポーネントを標準 BLEペリフェラルになるように構成する手順は次の 5つのステップです。 

ステップ 1: ご使用のデザインに適切なプロファイルとプロファイル ロールを選択します。図 12に示すように、BLEコンポーネント

は、選択したプロファイル ロールに必要な GAPと GATTロールを自動的に選択します。 

https://developer.bluetooth.org/TechnologyOverview/Pages/Profiles.aspx
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図 12. BLEプロファイルのコンフィギュレーション 

Pick a Profile

Pick a Profile Role

GAP role is auto selected

Select Profile 

Collection

 

ステップ 2: 選択したプロファイル ロールに応じて、サポートされるすべての GATT サービスと該当するキャラクタリスティック

がプロファイル仕様に従って自動生成されます。サービスとキャラクタリスティック値を確認し、必要に応じて編集します。

Profiles タブ内の設定情報は、選択したデザインのアトリビュート データベースになります。 

図 13. BLEアトリビュート データベースのコンフィギュレーション 

Find Me Target Profile 

Attribute Database

GAP Service

GATT Service

Alert Service  as per 

Find Me Profile Spec

Characteristic Value

Characteristic Descriptor

 

ステップ 3: 図 14 と図 15に示すように、ご使用のデザインの GAPの一般設定と広報データのコンフィギュレーションを構成

します。   
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図 14. BLE GAPのコンフィギュレーション 

Choose how your 

device appears on 

the peer side

Name your device

Enter or auto-generate 

device address

 

図 15. BLE広報データのコンフィギュレーション 

Choose what to advertise

 

ステップ 4: ファームウェアを書いて、構成したデザインを初期化します。BLE コンポーネントに対応するアプリケーション層の

イベント ハンドラを登録して、BLE コンポーネントからのイベントとデータを受信させます。イベント ハンドラは、GAP、GATT

やその他の一般的なイベントに対応する一般イベント ハンドラ、およびサービス固有イベントに対応するサービス固有イベン

ト ハンドラ (対応するサービスごとに 1つのイベント ハンドラ) の 2種類です。 

ステップ 5: プログラムのメイン ループで待機して、BLEコンポーネントからイベントが発生したら、必要なアクションを取るか、

または BLEコンポーネント APIを使用してセントラル デバイスにデータを送信します。  
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5 PRoC BLE開発セットアップ 

図 16 に、PRoC BLE デバイスを用いて BLE ペリフェラル設計を評価するために必要なハードウェアとソフトウェア ツールを

示します。BLE Pioneer Kit (図 16に示す赤色の基板上の黒いモジュール) は、セントラル デバイスとして機能する CySmart 

iOS/Android アプリまたは CySmart ホスト エミュレーション ツールと通信できるペリフェラルとして機能します。また、

CySmartホスト エミュレーション ツールの動作には BLE ドングル (図 16に示す黒色の基板) が必要です。図 17に、BLE設

計のプログラミングとデバッグに必要な開発システムのセットアップを示します。 

図 16. BLE機能的セットアップ 
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図 17. BLE開発セットアップ 
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6 初めての PRoC BLE設計 

本節で、PSoC Creatorを使用して PRoC BLEのシンプルな設計を作成する手順を説明します。 

6.1 設計について 

本設計では、即時アラート サービス (IAS) に対応する Targetロールの BLE Find Meプロファイルを実装します。図 18に示

すように、Find Meプロファイルでは、Find Me Locatorという機能がアラート レベルを変化させます。アラート レベルが変化

する度に、BLE Pioneer Kit上の LEDの点灯状態が変わります。その他、2個のステータス LEDが備わっており、BLE イン

ターフェースの状態を示すために使用されます。 

図 18. 初めての PSoC 4 BLE設計 

Find Me Collector 

(CySmart PC/Mobile App)

IAS GATT Client

Write Alert Level

Find Me Target 
(BLE Pioneer Kit)

IAS GATT Server

Service

IAS

Characteristic

Alert Level

Immediate Alert Service

No Alert (
0x00)

High Alert (0x02)

Mild Alert (0x01)

LED OFF

LED BLINK

LED ONMap to PSoC Creator 

Schematic

 

6.2 事前準備 

実装を行う前に、必ず BLE Pioneer Kitを入手し、以下のソフトウェアをインストールしてください。 

 PSoC Creator 3.2 (またはそれ以降) および PSoC Programmer 3.23.0 (またはそれ以降)  

 CySmartホスト エミュレーション ツールまたは iOS/Android向け CySmartアプリ 

初めての EZ-BLE PRoCモジュール設計の作成手順は以下の 4段階を踏みます。 

1. PSoC Creator回路図ページで設計を作成し設定します。 

2. BLEイベントを初期化および処理するようにファームウェアを書きます。 

3. BLE Pioneer Kit上の PRoC BLEデバイスをプログラムします。  

4. CySmartホスト エミュレーション ツールまたはモバイル アプリを使用して設計をテストします。 

https://developer.bluetooth.org/gatt/services/Pages/ServiceViewer.aspx?u=org.bluetooth.service.immediate_alert.xml
https://www.bluetooth.org/docman/handlers/downloaddoc.ashx?doc_id=239389
http://www.cypress.com/go/cy8ckit-042-ble
http://www.cypress.com/go/creator
http://www.cypress.com/go/programmer
http://www.cypress.com/go/cysmart
https://itunes.apple.com/us/app/cysmart/id928939093?mt=8
https://play.google.com/store/apps/details?id=com.cypress.cysmart&hl=en
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注: 本アプリケーション ノートで説明する BLEサンプル設計の PSoC Creator機能プロジェクトはアプリケーション ノートのウ

ェブページに掲載されませんが、PSoC Creator のサンプル プロジェクトに含まれています。サンプル プロジェクト (File > 

Example Projectを選択して、Keywordを Find Me > BLE_FindMe として選択すること) で開始することが可能です。サ

ンプル プロジェクトで開始する場合、上記のステップ 1と 2 (以下の節 6.3と 6.4) を飛ばしてステップ 3と 4 (以下の節 6.5と

6.6) から進んでください。  

6.3 第 1段階: 設計を作成／設定 

本節では、設計プロセスの概要について順に説明します。空のプロジェクトを作成してから、ハードウェアとファームウェア設

計入力について解説します。  

1. PSoC Creatorホームページから PSoC Creator 3.2またはそれ以降のバージョンをご使用の PCにインストールしてく

ださい。  

2. PSoC Creatorを起動し、図 19に示すように File > New > Projectを選択します。 

図 19. プロジェクトの新規作成 

 

 

3. 図 20 に示すように、PRoC BLE Design のプロジェクト テンプレートを選択して、プロジェクトに名前を付けます (例：

「BLE_FindMe」)。新規プロジェクトの適切な場所を選択します。 

図 20. 新規プロジェクトの命名 

 

4. Project > Device Selector を移動して、デバイスを選択します。開発キットを使用する場合、キットの型番を読み、また

はキットのガイドを参照して型番を調べてください。また、図 22に示すように、デバイス セレクタの Devices タブのエリア

で右クリックして Select Default Deviceを選択して PRoC BLE ファミリをクリックすることで、BLE Pioneer Kitに使用

する CYBL10563-56LQXIデバイスを選択できます。 

http://www.cypress.com/?id=2494&source=an79953
http://www.cypress.com/go/cy8ckit-042-ble
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注: CY5671 モジュールには CYBL10X6X デバイス ファミリを選び、CY5676 モジュールには CYBL10X7X デバイス  

ファミリを選びます。  

図 21. デバイス セレクタの起動 

 

 

図 22. デバイス セレクタ 

 

 

5. 新規プロジェクトを作成すると、ベースライン ファイル一式を格納するプロジェクト フォルダが作成されます。図 23に示す

ように、これらのファイルが Workspace Explorer ウィンドウに表示されます。TopDesign.cysch ファイルをダブルクリック

して、プロジェクトの回路図を開きます。 
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図 23. Top Design回路図を開く 

 

図 24に示すように、「TopDesign.cysch」には予め用意された回路図が表示されます。 

図 24. 事前追加の回路図 

 

 

6. 各コンポーネントを右クリックして対応するオプションを選択することで該当のコンポーネントを無効にする (または削除する) 

ことができます ( 図 25をご参照ください)。本設計では次のコンポーネントを無効にします。 

 「BATTERY MONITOR」セクションからの ADC_SAR_Seq_1および ADC_In 

 すべての GPIOボタン (SW1～SW5) 

 「TIMER」セクションからの TCPWM_1、Clock_1、および isr_1 

 “Gyro + Accelerometer Interface”セクションからの SCB_1 

 「Mic Interface」セクションからの I2S_1、Clock_4、SCK、SDI、およびWS 
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図 25. コンポーネントを有効／無効にする 

 

 

7. LED_1 と LED_2 の間で 1 個の LED を追加します。追加するには、まずは、新規 LED に合わせるように LED_1 と

LED_2 の回路図の間の間隔を増やします。図 26 に示すように、LED_1 回路図を選択して右クリックして Copy を選び、

また右クリックして Pasteを選んで LED_3を作成します。  

図 26. LEDをもう 1つ追加 

 

 

8. 回路図内の BLEコンポーネントをダブルクリックし、以下の特性を持つ「BLE Find Me Target」に設定します。 

 図 27 に示すように、GAP の役割 (GAP Role) を「Peripheral」に、プロファイルの役割 (Profile role) を「Find Me 

Target (GATT server)」に設定します。Find Meプロファイルのサービスとキャラクタリスティックは図 28に示すよう

に (初期設定の値のままに) します。 

 図 29 に示すように、GAP のデバイス名 (Device name) を「Find Me Target」に、その表示(Appearance) を 

「Generic Keying」に設定します。「Silicon generated “Company assigned” part of device address」にチェックを

入れます。 

 図 30に示すように、広報モードを「Limited」に、広報タイムアウトを「30」秒に、高速広報期間を 20～30msに設定し

ます。「Slow advertising interval」チェックボックスにチェックを外します。 
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 図 31 と図 32 に示すように、Advertisement Packet で「Flags」を選択し、「Service UUID」フィールドの下の

Immediate Alert を選んでそのフィールドを有効にし、Scan Response Packet で「Local Name」と「Appearance」 

フィールドを有効にします。 

 図 33に示すように、GAPのセキュリティ レベルを最低レベル (Mode 1、No Security) に設定すると、データ交換時

に認証、暗号化、認可、または接続が不要になります。 

図 27. BLEコンポーネントの一般設定 

 

 

図 28. BLEコンポーネントのプロファイル設定 
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図 29. BLEコンポーネントの GAP一般設定 

 

 

図 30. BLEコンポーネントの GAP広報設定 
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図 31. BLEコンポーネントの GAP広報パケット 

 

 

図 32. BLEコンポーネントの GAPスキャン応答パケット 
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図 33. BLEコンポーネントの GAPセキュリティ設定 

 

 
9. 図 34と図 35に示すように、「External Terminal」が選択されている状態で LED_1と LED_2の名前をそれぞれ Advert

ising_LED と Disconnect_LED に変更します。BLE Pioneer Kit 上の LED はアクティブ LOW のため、「Initial drive 

state」を「High(1)」にします。すなわち、駆動ピンが HIGH になると、LED は消灯し、駆動ピンが LOW になると、LED は

点灯します。こられの LEDは BLE広報と接続切断状態を指示するために使用されます。 

図 34. LED_1コンフィギュレーション 
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図 35. LED_2コンフィギュレーション 

 

 

10. 図 36に示すように、「External Terminal」が選択されている状態で LED_3の名前を Alert_LEDに変更し、「Initial drive 

state」を「High(1)」に設定します。  

図 36. LED_3コンフィギュレーション 
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11. 回路図設定を完了した後の設計は図 37のようになります。  

図 37. 回路図のコンフィギュレーション 

 

注: 図 37に示した青色の点線、LED記号、抵抗記号はチップ外部の PSoC Creatorコンポーネントであり、説明のため

にのみ表示され、設計の機能には不要です。チップ外部のコンポーネントを設計に追加したい場合、PSoC Creator の 

チップ外部コンポーネント カタログから必要なチップ外部コンポーネントをプロジェクト回路図ページにドラッグ アンド 

ドロップします。 

12. Workspace Explorerから BLE_FindMe.cydwrファイル (Design-Wide Resourcesファイル) を開き、Pinsタブをクリッ

クします。このタブでは、出力のデバイス ピン (Advertising_LED、Disconnect_LED、Alert_LED) を選択できます。図 38

に、Advertising_LED、Disconnect LED、Alert_LED のピンを BLE Pioneer Kit 上のそれぞれ緑色 LED、赤色 LED、 

青色 LEDに接続するピン コンフィギュレーションを示します。 

図 38. ピンの選択 
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13. 同様に、図 39に示すように、BLE_FindMe.cydwrファイルの下の Clocks タブでは、IMOをダブルクリックして内部主発

振器 (IMO) を 12MHzに設定します。OKをクリックします。 

図 39. クロックの設定 

 

14. Build メニューから Generate Applicationを選択します。図 40に示すように、Workspace Explorerウィンドウには、

PSoC Creator によって自動的に生成された BLE、クロック、およびデジタル出力／入力ピン コンポーネントのソース 

コード ファイルが表示されています。 

図 40. 生成されたソース ファイル 
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6.4 第 2段階: アプリケーション コードを書く  

PSoC Creatorで BLE標準プロファイルのアプリケーションを設計するには、以下の 4つの主なファームウェア ブロックが必

要です。 

 システム初期化 

 BLEスタック イベント ハンドラ 

 BLEサービス固有イベント ハンドラ 

 メイン ループおよび低消費電力実装 

本節で、第 1段階: 設計を作成／設定で設定した設計に応じて各ブロックの詳細を説明します。 

6.4.1 システム初期化  

PRoC BLE デバイスがリセットされると、ファームウェアはシステムの初期化を実行しなければなりません。このプロセスでは、

プラットフォームが初期化され、グローバル割り込みおよび設計で使用するすべてのコンポーネントが有効化されます。 

システムが初期化された後、ファームウェアは BLEコンポーネントを初期化し、その結果、BLEサブシステム全体が内部的に

初期化されます。  図 41にシステムの初期化のフロー図を示します。 

BLE コンポーネントの初期化プロセスの一部として、保留中のイベントを通知するために BLE スタックによって呼び出される

イベント ハンドラ関数を登録する必要があります。図 44に示す BLEスタック イベント ハンドラは BLEの初期化の一部として

登録されます。BLEコンポーネントの初期化が正常に完了すると、ファームウェアは IAS固有イベント用のイベント ハンドラを

登録し、制御権をメイン ループに切り替えます。メインループ コードのセグメントは節 6.4.4 メインループおよび低消費電力動作 

に説明されます。図 42にシステム初期化のファームウェア ソースコードを示します。 

図 41. システム初期化のフロー図 
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図 42. システム初期化のファームウェア 

#include <project.h> 

 

#define LED_ON                  (0u) 

#define LED_OFF                 (1u) 

 

#define NO_ALERT                (0u) 

#define MILD_ALERT              (1u) 

#define HIGH_ALERT              (2u) 

 

#define LED_TOGGLE_TIMEOUT      (100u) 

 

void StackEventHandler(uint32 event, void *eventParam); 

void IasEventHandler(uint32 event, void *eventParam); 

 

uint8 alertLevel; 

 

int main() 

{ 

  CYBLE_API_RESULT_T apiResult; 

 

  CyGlobalIntEnable; 

 

  apiResult = CyBle_Start(StackEventHandler); 

 

  if(apiResult != CYBLE_ERROR_OK) 

  { 

    /* BLE stack initialization failed, check your configuration */ 

    CYASSERT(0); 

  } 

 

  CyBle_IasRegisterAttrCallback(IasEventHandler); 

 

  /* Place the main application loop here */ 

 

} 
 

6.4.2 BLE スタック  イベント  ハンドラ  

BLE コンポーネント内の BLE スタックはイベントを生成し、CyBle_Start API 呼び出しで登録された BLE スタック イベント  

ハンドラを介して BLE インターフェースの状態とデータをアプリケーション ファームウェアに提供します。イベント ハンドラは、

スタックからのいくつかの基本的なイベントを処理し、そのスタックを設定して BLE 接続を確立および維持します。本書に述べる

Find Me アプリケーションでは、BLE スタック イベント ハンドラは表 1 で説明するすべてのイベントを処理します。図 43 と 

図 44に、BLEスタック イベント処理のフロー図とファームウェアを示します。 

表 1. BLEスタック イベント 

BLEスタック イベント名 イベントの説明 イベント ハンドラの応答処理 

CYBLE_EVT_STACK_ON 
BLEコンポーネント内の BLEファーム 

ウェア スタックの初期化が正常に完了 
広報を開始し、広報状態を LEDに反映 

CYBLE_EVT_GAP_DEVICE_DISCONNECTED ピア デバイスとの BLE接続切断 広報を再実行し、広報状態を LEDに反映 

CYBLE_EVT_GAP_DEVICE_CONNECTED ピア デバイスとの BLE接続確立 BLE接続状態を LEDに更新 

CYBLE_EVT_GAPP_ADVERTISEMENT_START_STOP BLEスタックの広報開始／停止イベント 
広報がタイムアウトした場合、デバイスを 

ストップ モードに設定 
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図 43. BLEスタック イベント ハンドラのフロー図  
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図 44. BLEスタック イベント ハンドラのファームウェア 

void StackEventHandler(uint32 event, void *eventParam) 

{ 

    switch(event) 

    { 

        /* Mandatory events to be handled by Find Me Target design */ 

        case CYBLE_EVT_STACK_ON: 

        case CYBLE_EVT_GAP_DEVICE_DISCONNECTED: 

            /* Start BLE advertisement for 30 seconds and update link 

             * status on LEDs */ 

            CyBle_GappStartAdvertisement(CYBLE_ADVERTISING_FAST); 

            Advertising_LED_Write(LED_ON); 

            alertLevel = NO_ALERT; 

        break; 

 

        case CYBLE_EVT_GAP_DEVICE_CONNECTED: 

            /* BLE link is established */ 

            Advertising_LED_Write(LED_OFF); 

            Disconnect_LED_Write(LED_OFF); 

        break; 

              
        case CYBLE_EVT_GAPP_ADVERTISEMENT_START_STOP: 

            if(CyBle_GetState() == CYBLE_STATE_DISCONNECTED) 

            { 
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6.4.3 BLE サービス固有イベント  ハンドラ  

BLE コンポーネントはまた、設計でサポートされる各サービスに対応するイベントを生成します。ご作成中の Find Me Target

アプリケーションでは、BLE コンポーネントはアラート レベルのキャラクタリスティックが新しい値に更新されるかをアプリケー

ションに通知する IASイベントを生成します。図 45と図 46に BLE IASイベントのフロー図とファームウェアを示します。 

図 45. BLE IASイベント ハンドラのフロー図 
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図 46. BLE IASイベント ハンドラのファームウェア 

void IasEventHandler(uint32 event, void *eventParam) 

{ 

    /* Alert Level Characteristic write event */ 

    if(event == CYBLE_EVT_IASS_WRITE_CHAR_CMD) 

    { 

        /* Read the updated Alert Level value from the GATT database */ 

        CyBle_IassGetCharacteristicValue(CYBLE_IAS_ALERT_LEVEL,  

            sizeof(alertLevel), &alertLevel); 

    } 

} 

                /* Advertisement event timed out, go to low power  

                 * mode (Stop mode) and wait for device reset 

                 * event to wake up the device again */ 

                Advertising_LED_Write(LED_OFF); 

                Disconnect_LED_Write(LED_ON); 

                CySysPmSetWakeupPolarity(CY_PM_STOP_WAKEUP_ACTIVE_HIGH); 

                CySysPmStop(); 

                

                /* Code execution will not reach here */ 

            } 

        break; 

 

        default: 

        break; 

    } 

} 
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6.4.4 メインループおよび低消費電力動作  

設計のメイン ループ ファームウェアは、BLE スタック処理イベントを定期的に処理し、IASのアラート レベルのキャラクタリス

ティック値に応じて青色 LED を更新し、接続期間との間に BLESS ブロックと PRoC BLE システムを低消費電力モードに設

定します。図 47 および図 48 にメイン ロープのフロー図とファームウェアを示します。このメイン ループのコードは、サービス

固有イベント ハンドラを登録するためにmain関数内の呼び出し関数の次に配置することを推奨します。  

図 47. メイン ループのフロー図 
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図 48. ファームウェアのメインループ  

for(;;) 

{ 

    static uint8 toggleTimeout = 0; 

    CYBLE_BLESS_STATE_T blessState; 

    uint8 intrStatus; 

 

    /* Single API call to service all the BLE stack events. Must be 

     * called at least once in a BLE connection interval */ 

    CyBle_ProcessEvents(); 

    /* Update Alert Level value on the blue LED */ 

    switch(alertLevel) 

    { 

        case NO_ALERT: 

        Alert_LED_Write(LED_OFF); 

        break; 

 

        case MILD_ALERT: 

        toggleTimeout++; 

        if(toggleTimeout == LED_TOGGLE_TIMEOUT) 

        { 
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            /* Toggle alert LED after timeout */ 

            Alert_LED_Write(Alert_LED_Read() ^ 0x01); 

            toggleTimeout = 0; 

        } 

        break; 

 

        case HIGH_ALERT: 

        Alert_LED_Write(LED_ON); 

        break; 

    } 

 

    /* Configure BLESS in Deep-Sleep mode */ 

    CyBle_EnterLPM(CYBLE_BLESS_DEEPSLEEP); 

     

    /* Prevent interrupts while entering system low power modes */ 

    intrStatus = CyEnterCriticalSection(); 

     

    /* Get the current state of BLESS block */ 

    blessState = CyBle_GetBleSsState(); 

     

    /* If BLESS is in Deep-Sleep mode or the XTAL oscillator is turning 

on,  

     * then PSoC 4 BLE can enter Deep-Sleep mode (1.3uA current 

consumption) */ 

    if(blessState == CYBLE_BLESS_STATE_ECO_ON ||  

        blessState == CYBLE_BLESS_STATE_DEEPSLEEP) 

    { 

        CySysPmDeepSleep(); 

    } 

    else if(blessState != CYBLE_BLESS_STATE_EVENT_CLOSE) 

    { 

        /* If BLESS is active, then configure PSoC 4 BLE system in  

         * Sleep mode (~1.6mA current consumption) */ 

        CySysPmSleep(); 

    } 

    else 

    { 

        /* Keep trying to enter either Sleep or Deep-Sleep mode */     

    } 

    CyExitCriticalSection(intrStatus); 

     

    /* BLE link layer timing interrupt will wake up the system from 

Sleep  

     * and Deep-Sleep modes */ 

} 
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6.5 第 3段階: デバイスをプログラム 

本節は、PSoC Creator を使用してデバイスをプログラムする方法を示します。プログラマ内蔵の開発キットを使用する場合、

USB ケーブルでキット基板をコンピュータに接続します。その他のキットについては、キット ガイドをご参照ください。自分の 

ハードウェアで開発する場合、デバイスをプログラムするためにサイプレス CY8CKIT–002 MiniProg3 などのハードウェア  

デバッガが必要です。 

図 49に示すように、PSoC Creatorで、 Debug > Select Debug Targetを選択します。 

図 49. デバッグ対象の選択 

 

1. 図 50 に示すように、Select Debug Target ダイアログ ボックスで Port Acquire をクリックして Connect をクリックします。 

OKをクリックして、ダイアログ ボックスを閉じます。 

図 50. デバイスに接続 

 

http://www.cypress.com/?rID=38154&source=an79953
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2. 図 51に示すように、Debug > Programを選択してプロジェクトをデバイスにプログラムします。 

図 51. デバイスのプログラム 

 

3. 図 52に示すように、プログラミングの状態は PSoC Creatorのステータス バー (画面の左下隅) に表示されます。 

図 52. プログラミングの状態 

 

6.6 第 4段階: 設計をテスト 

本節では、CySmartモバイル アプリと PCアプリを用いて BLE設計をテストする方法を説明します。図 16に、BLE Pioneer 

Kitを用いた設計テストのセットアップを示します。 

1. ご使用の iOSまたは Androidモバイル機器の Bluetooth機能をオンにします。 

2. CySmartアプリを起動します。 

3. BLE Pioneer Kit上のリセット スイッチを押してご開発の設計からの BLE広報を開始します。 

4. CySmart アプリのホーム画面をプルダウンし、BLE ペリフェラルのスキャンを開始します。これで、ご使用のデバイスは

CySmartアプリのホーム画面に表示されます。ご使用のデバイスを選択して BLE接続を確立します。 

5. カルーセル画面で「Find Me」プロファイルを選択します。 

6. Find Me Profile画面でアラート レベルの 1つを選択します。ご覧のように、デバイス上の LED状態が選択に応じて変

化します。 

図 53と図 54に、CySmartモバイル アプリの設定手順を示します。 
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図 53. iOSアプリ CySmartでのテスト 
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図 54. Androidアプリ CySmartでのテスト 
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CySmartモバイル アプリと同様に、CySmartホスト エミュレーション ツールを使用してご開発の設計との BLE接続を確立し、

BLEキャラクタリスティックに対して読み書き処理を実行できます。 

1. BLE ドングルをご使用のWindowsマシンに接続します。ドライバーのインストールが完了するまで待ちます。 

2. CySmart ホスト エミュレーション ツールを起動します。ツールは自動的に BLE ドングルを検出します。BLE ドングルが

Select BLE Dongle Targetポップアップ ウィンドウに表示されない場合、Refreshをクリックします。図 55に示すよう

に Connectをクリックします。 
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図 55. CySmartでの BLE ドングル選択 

                    

 

3. 図 56に示すように、Configure Master Settingsを選択して初期設定値を復元します。 

図 56. 「CySmart Master Settings」コンフィギュレーション 

 

4. BLE Pioneer Kit上のリセット スイッチを押してご開発の設計からの BLE広報を開始します。 

5. CySmart ホスト エミュレーション ツールで Start Scan をクリックします。図 57 に示すように、ご使用のデバイスが

Discovered devices リストに表示されます。 
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図 57. CySmartでのデバイス検出 

 

6. 図 58 に示すように、ご使用のデバイスを選択し、Connect をクリックして CySmart ホスト エミュレーション ツールとの

BLE接続を確立します。 

図 58. CySmartでのデバイス接続 

 

 

7. 接続が確立された後、図 59に示すように、CySmartホスト エミュレーション ツールでご開発の設計のすべてのアトリビュー

トを検出します。 

図 59. CySmartでの属性検出 

 

 

8. 図 60に示すように、Immediate Alert Serviceの下の Alert Level Characteristicに値 0、1、2のいずれかを書きます。

ご覧のように、ご使用のデバイス上の LED状態がアラート レベル特性の設定に応じて変化します。  
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図 60. CySmartホスト エミュレーション ツールでのテスト 

 

7 まとめ  

本アプリケーション ノートは BLE プロトコルと PRoC BLE デバイスのアーキテクチャおよび開発ツールの基礎について説明

しました。PSoC 4 BLEは、BLE無線ブロック、デジタルのペリフェラル機能、メモリ、ARM Cortex-M0マイクロコントローラー

を単一チップに集積した真のプログラマブル組込みシステム オン チップです。集積した機能および低電力モードが整備され

たため、PRoC BLEはバッテリ駆動ウェアラブル機器、健康関連製品の BLEアプリケーションに最適になります。 

本アプリケーション ノートはまた、PRoC BLEを迅速に深く理解できるように総合的なリソース収集へのアクセスも提供しまし

た。 

8 関連アプリケーション ノート 
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9 付録 A: BLEデバイス ファミリの比較 

表 2はサイプレスの BLEデバイス ファミリの特長と機能をまとめます。 

表 2. BLEデバイス ファミリ 

機能 

 デバイス ファミリ 

CY8C41x7-BL CY8C42x7-BL CYBL10X6X CYBL10X7X CY8C41x8-BL CY8C42x8-BL 

BLEサブシステム Bluetooth 4.1対

応のプロトコル  

スタックを持つ

BLE無線とリンク

層ハードウェア  

ブロック 

Bluetooth 4.1対

応のプロトコル  

スタックを持つ

BLE無線とリンク

層ハード 

ウェア ブロック 

Bluetooth 4.1対応

のプロトコル スタッ

クを持つ BLE無線

とリンク層ハード 

ウェア ブロック 

Bluetooth 4.1対応

のプロトコル スタッ

クを持つ BLE無線

とリンク層ハード 

ウェア ブロック 

Bluetooth 4.1対

応のプロトコル 

スタックを持つ

BLE無線とリンク

層ハードウェア 

ブロック 

Bluetooth 4.1対応

のプロトコル スタッ

クを持つ BLE無線

とリンク層ハード 

ウェア ブロック 

CPU 24MHz ARM 
Cortex-M0 

CPU、シングル 

サイクルの乗算 

に対応 

48MHz ARM 

Cortex-M0 CPU、

シングル サイクル

の乗算に対応 

48MHz ARM 

Cortex-M0 CPU、

シングル サイクル

の乗算に対応 

48MHz ARM 

Cortex-M0 CPU、

シングル サイクル

の乗算に対応 

24MHz ARM 
Cortex-M0 

CPU、シングル

サイクルの乗算

に対応 

48MHz ARM 

Cortex-M0 CPU、

シングル サイクル

の乗算に対応 

フラッシュ メモリ 128KB 128KB 128KB 256KB 256KB 256KB 

SRAM 16KB 16KB 16KB 32KB 32KB 32KB 

GPIO 最大 36 最大 36 最大 36 最大 36 最大 36 最大 36 

Ca pSense 最大 35個の 

センサー 

最大 35個の 

センサー 

最大 35個の 

センサー 

最大 35個のセン

サー 

最大 35個の 

センサー 

最大 35個の 

センサー 

CapSense 

ジェスチャー 
一部の 

デバイスのみ 

一部の 

デバイスのみ 

一部の 

デバイスのみ 

一部の 

デバイスのみ 

一部の 

デバイスのみ 

一部の 

デバイスのみ 

ADC シーケンサーを 

備えた 12ビット、
806ksps SAR 
ADC 

シーケンサーを 

備えた 12ビット、
1Msps SAR ADC 

シーケンサーを 

備えた 12ビット、
1Msps SAR ADC 

シーケンサーを 

備えた 12ビット、
1Msps SAR ADC 

シーケンサーを

備えた 12ビット、
806ksps SAR 
ADC 

シーケンサーを 

備えた 12ビット、
1Msps SAR ADC 

オペアンプ ディープスリープ 

モードでアクティブ

な 2個の 

プログラマブルな

オペアンプ 

ディープスリープ 

モードでアクティブ

な 4個の 

プログラマブルな

オペアンプ 

なし なし 

ディープスリープ 

モードでアクティ

ブな 2個の 

プログラマブルな

オペアンプ 

ディープスリープ  

モードでアクティブ

な 4個の 

プログラマブルな

オペアンプ 

コンパレータ ウェイクアップ機

能を備えた 2個

の低消費電力 

コンパレータ 

ウェイクアップ機能

を備えた 2個の 

低消費電力 

コンパレータ 

なし なし 

ウェイクアップ機

能を備えた 2個

の低消費電力 

コンパレータ 

ウェイクアップ機能

を備えた 2個の 

低消費電力 

コンパレータ 

電流 DAC 7ビット (1個) 、 

8ビット (1個) 

7ビット (1個) 、 

8ビット (1個) 
なし なし 

7ビット (1個) 、 

8ビット (1個) 

7ビット (1個) 、 

8ビット (1個) 

電源供給範囲 1.9V～5.5V 1.9V～5.5V 1.9V～5.5V 1.9V～5.5V 1.9V～5.5V 1.9V～5.5V 

低消費電力モード ディープ スリープ 

モード: 1.3µAを

消費 

ハイバネート  

モード: 150nAを

消費 

ストップ モード: 

60nAを消費 

ディープ スリープ 

モード: 1.3µAを消

費 

ハイバネート モー

ド: 150nAを消費 

ストップ モード: 

60nAを消費 

ディープ スリープ 

モード: 1.3µAを消

費 

ハイバネート モー

ド: 150nAを消費 

ストップ モード: 

60nAを消費 

ディープ スリープ 

モード: 1.3µAを消

費 

ハイバネート モー

ド: 150nAを消費 

ストップ モード: 

60nAを消費 

ディープ スリープ 

モード: 1.3µAを

消費 

ハイバネート 

モード: 150nAを

消費 

ストップ モード: 

60nAを消費 

ディープ スリープ  

モード: 1.3µAを消

費 

ハイバネート モー

ド: 150nAを消費 

ストップ モード: 

60nAを消費 
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機能 

 デバイス ファミリ 

CY8C41x7-BL CY8C42x7-BL CYBL10X6X CYBL10X7X CY8C41x8-BL CY8C42x8-BL 

セグメント LCD 

駆動 

一部のデバイスで

の 4 COM、 

32セグメントの

LCD駆動 

一部のデバイスで

の 4 COM、 

32セグメントの

LCD駆動 

一部のデバイスで

の 4 COM、 

32セグメントの

LCD駆動 

一部のデバイスで

の 4 COM、 

32セグメントの

LCD駆動 

一部のデバイス

での 4 COM、 

32セグメントの

LCD駆動 

一部のデバイスで

の 4 COM、 

32セグメントの

LCD駆動 

シリアル通信 プログラマブルな

I
2
C、SPI、または

UARTを備えた 

2個の個別の 

シリアル通信 

ブロック (SCB) 

プログラマブルな

I
2
C、SPI、または

UARTを備えた 

2個の独立した
SCB 

プログラマブルな

I
2
C、SPIまたは

UARTを備えた 

1個または 2個の

独立した SCB 

プログラマブルな

I
2
C、SPIまたは

UARTを備えた 

1個または 2個の

独立した SCB 

プログラマブルな

I
2
C、SPI、または

UARTを備えた

2個の独立した

シリアル通信 

ブロック (SCB) 

プログラマブルな

I
2
C、SPI、または

UARTを備えた 

2個の独立した
SCB 

タイマー／カウン

タ／パルス幅変調

器 (TCPWM) 
4 4  4  4  4 4  

汎用デジタル 

 ブロック (UDB) 

なし 

4個、各々は 8つ

のマクロセルおよ

び 1つのデータ 

パスを備える追加

のデジタル ペリフ

ェラル (タイマー、

カウンター、PWM) 

または通信 

インターフェース 

(UART、SPI) を合

成するのに使用可

能 

なし なし なし 

4個、各々は 8つ

のマクロセルおよ

び 1つのデータ 

パスを備える追加

のデジタル ペリフ

ェラル (タイマー、

カウンター、PWM) 

または通信 

インターフェース 

(UART、SPI) を合

成するのに使用可

能 

追加のデジタル 

ペリフェラル (I
2
S、

PWM) 
なし 

あり (一部のデバ

イスでの UDB 

ベースのデジタル 

ペリフェラル) 

あり (一部のデバ

イスでの固定機能

ブロック) 

あり (一部のデバ

イスでの固定機能

ブロック) 

なし 

あり (一部のデバ

イスでの UDB 

ベースのデジタル 

ペリフェラル) 

クロック  IMO: 3MHz～
24MHz 

ILO: 32kHz 

ECO: 24MHz  

WCO: 32kHz 

IMO: 3MHz～
48MHz  

ILO: 32kHz 

ECO: 24MHz 

WCO: 32kHz 

IMO: 3MHz～
48MHz 

ILO: 32kHz 

ECO: 24MHz 

WCO: 32kHz 

IMO: 3MHz～
48MHz 

ILO: 32kHz 

ECO: 24MHz 

WCO: 32kHz 

IMO: 3MHz～
24MHz 

ILO: 32kHz 

ECO: 24MHz 

WCO: 32kHz 

IMO: 3MHz～
48MHz 

ILO: 32kHz 

ECO: 24MHz 

WCO: 32kHz 

電源電圧監視 パワーオン リセッ

ト (POR) 

電圧低下検出 

(BOD) 

低電圧検出 

(LVD) 

POR 
BOD 
LVD 

POR 
BOD 
LVD 

POR 
BOD 
LVD 

POR 
BOD 
LVD 

POR 
BOD 
LVD 

パッケージ 56-QFN (7.0 × 
7.0 × 0.6mm)  

および  

68-WLCSP (3.52 
× 3.91 × 
0.55mm) 

56-QFN (7.0 × 
7.0 × 0.6mm) 

 および  

68-WLCSP (3.52 
× 3.91 × 0.55mm) 

56-QFN (7.0 × 
7.0 × 0.6mm)  

および  

68-WLCSP (3.52 
× 3.91 × 0.55mm) 

56-QFN (7.0 × 
7.0 × 0.6mm)  

および  

68-WLCSP (3.52 
× 3.91 × 0.55mm) 

56-QFN* (7.0 × 
7.0 × 0.6mm)  

および  

76-WLCSP 
(4.04 × 3.87 × 
0.55mm) 

56-QFN* (7.0 × 
7.0 × 0.6mm)  

および  

76-WLCSP (4.04 
× 3.87 × 0.55mm) 
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10 付録 B : サイプレスの専門用語 

本節では、サイプレスの PSoCファミリのデバイスで操作する際によく出てくる用語について説明します。 

コンポーネント コンフィギュレーション ツール: PSoC Creator の簡単な GUI で、各コンポーネントに組み込まれています。 

コンポーネント パラメーターをカスタマイズするために使用され、コンポーネントを右クリックすることでアクセスされます。 

コンポーネント: PSoC Creator ソフトウェア上にアイコンとして表示する無償の組み込み IC です。これらのコンポーネントは

複数の ICとシステム インターフェースを、本質的にメイン システム バスを介してMCUに接続される 1個の PSoCコンポー

ネントに統合するのに使用されます。例えば、BLE コンポーネントで Bluetooth Smart 製品をほんの数分で作成できます。 

同様に、プログラム可能なアナログ コンポーネントをセンサー用に使用できます。 

MiniProg3: 開発用のプログラミング ハードウェアであり、内蔵のプログラマがサポートされていないカスタム基板または

PSoC開発キットの上に PSoCデバイスをプログラムするために使用されます。 

PRoC BLE: Bluetooth 4.1仕様に対応するロイヤリティフリーの BLEプロトコル スタックを含む BLE無線ブロックを統合した

固定機能の SoCです。 

PSoC Creator: 開発を行うお客様の PC にインストールされた PSoC 3、PSoC 4、および PSoC 5LP の統合設計環境 

(IDE) ソフトウェアであり、PSoC システムのハードウェアとファームウェアを同時に設計するか、またはハードウェア設計後に

一般的な IDEへエクスポートすることを可能にします。 

PSoC Programmer: PSoC デバイスをプログラムするための柔軟性のある統合プログラム アプリケーションです。PSoC 

Programmerは PSoC Creatorと統合され、PSoC 3、PSoC 4、PRoC、および PSoC 5LP設計をプログラムします。 

 

http://www.cypress.com/?rID=38154
http://www.cypress.com/procble/
http://www.cypress.com/go/creator
http://www.cypress.com/go/programmer
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11 付録 C: サイプレス BLE開発ツール 

PRoC BLE開発キット 

図 61に示す BLEPioneer Kitは、PSoC BLEと PRoC BLE両方のデバイス ファミリに対応しているサイプレスの BLE開発

キットです。このキットは BLE Pioneer ベースボードに接続した取り外し可能な PRoC BLE (および PSoC 4 BLE) モジュール 

から成ります。このキットはコイン電池から、または USBインターフェースを介して電源供給を受けます。  

BLE Pioneer ベースボードと BLE モジュールを組み合わせて使用すれば、標準 Arduino Uno コネクタ準拠のシールドと 

併用する低消費電力のバッテリ式 BLEデバイス、または CapSenseユーザー インターフェースなどの基板搭載 PRoC BLE

デバイス機能を開発できます。  

BLE Pioneer ベースボードはオンボードプログラムとデバッグ インタフェースを搭載しているので、PSoC Creator IDE を介した

BLE設計のデバッグ処理は手早く簡単になります。BLE Pioneer Kitは Digilent®などの第三者ベンダーからの Pmod™ドーター 

カードとのインターフェースでの接続をサポートする追加のヘッダーを備えています。このキットは、BLE リンク マスターとして 

機能し、CySmart ホスト エミュレーション ツールと連動して、非 BLE Windows PC で BLE ホスト エミュレーション プラット 

フォームを実現する BLE ドングルも内蔵しています。  

このキットには、ユーザーが独自の BLE アプリケーションを開発できるように、BLE サンプル プロジェクトと資料一式が含ま

れています。キットの最新版、キット  デザイン、サンプル  プロジェクトやドキュメント  ファイルを入手するには、

www.cypress.com/go/CY8CKIT-042-BLEにアクセスしてください。 

図 61. BLE Pioneer Kit 

 
 

注: PRoC BLE 開発キットでは、PRoC BLE デバイス モジュール (「図 61.  BLE Pioneer Kit」での黒色のモジュール) は

128KB のフラッシュ メモリを持つ CYBL10X6X デバイスを内蔵しています。256KB のフラッシュ メモリを持つデバイス 

(CYBL10X7X) を内蔵しているモジュールはサイプレス ウェブサイトの CY5676ウェブページで個別に注文できます。 

11.1 CySmartホスト エミュレーション ツール 

CySmartホスト エミュレーション ツールは BLE Pioneer Kitの BLEドングルを使用して BLEセントラル デバイスをエミュレー

トするための Windows アプリケーションです。このアプリケーションは BLE Pioneer Kit の一部としてインストールされ、BLE

コンポーネントの右クリック オプションから起動できます。これは、ペリフェラルの BLE サービス、キャラクタリスティック、および 

アトリビュートを調べ、構成することで、GATTまたは L2CAP接続指向のチャネルを介して、ご使用の PSoC 4 BLEペリフェラ

ル実装をテストためのプラットフォームを提供します。 

 
 
 
 

http://www.cypress.com/go/CY8CKIT-042-BLE
http://www.cypress.com/CY5676
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CySmartホスト エミュレーション ツールを使用して実現できる動作は以下が含まれますが、これらに限定されません。 

 BLEペリフェラルをスキャンして、接続できるデバイスを検出する。 

 サービスとキャラクタリスティックなどの、接続したペリフェラル デバイスの BLEアトリビュートを検出する。 

 キャラクタリスティック バリューとディスクリプタに基づいて読み書きを行う。 

 接続したペリフェラル デバイスからのキャラクタリスティック通知および指示を受ける。 

 BLEセキュリティ マネージャを使用して、接続したペリフェラル デバイスとの結び (ボンド) を確立する。 

 ペリフェラル デバイスとの BLE L2CAP接続指向のセッションを設立し、Bluetooth 4.1仕様に従ってデータを交換する。 

図 62と図 63に、CySmartホスト エミュレーション ツールのユーザー インターフェースを示します。このツールのセットアップ

および使用方法の詳細については、Help メニュー内の CySmartユーザー ガイドをご参照ください。 
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図 62. CySmartホスト エミュレーション ツールのマスター デバイス タブ 

Advertisement and 

Scan Response Data

Discovered Device List

Log Window

Trusted Device List

 

 

図 63. CySmartホスト エミュレーション ツールのペリフェラル デバイス アトリビュート タブ 

Attribute Display 

and 

Configuration

List of Discovered 

Attributes
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11.2 CySmartモバイル アプリケーション 

PCツールの他に、それぞれのアプリケーション ストアからの iOSや Android用の CySmartモバイル アプリをダウンロードす

ることもできます。このアプリは、BLE 対応のスマートフォンを、ペリフェラル デバイスをスキャンして接続できるセントラル デバ

イスとして構成できるよう、それぞれの iOSコアの Bluetoothフレームワークと BLE用の Androidの組み込みプラットフォーム 

フレームワークを使用しています。 

モバイル アプリは、直観的な GUI を使用して SIG 採用の BLE 標準プロファイルをサポートし、基本的な BLE サービスおよび 

キャラクタリスティックの詳細を簡略化します。BLE標準プロファイルに加えて、アプリはサイプレスの LEDと CapSense実証

例を使用してカスタム プロファイルの実装を実証します。図 64 と図 65 に、CySmart アプリにおける心拍数プロファイル  

ユーザー インターフェースの一連のスクリーンショットを示しています。BLE Pioneer Kitのプロジェクト例を使用してアプリケー

ションを実行する方法については、BLE Pioneer Kitガイドを参照してください。  

図 64. CySmart iOSアプリ心拍数プロファイルの例 

 

図 65. CySmart Androidアプリ心拍数プロファイルの例 
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12 付録 D: PRoC BLEデバイス 

12.1 ARM Cortex-M0 とメモリ 

PRoC BLEは、32ビットの ARM Cortex-M0 CPUを内蔵し、最大 48MHzの周波数で動作可能で、43-DMIPS性能を実現

します。Cortex-M0 CPUはシングル サイクルの 32ビット乗算をサポートします。PRoC BLEは最大 32KBの SRAMおよび

最大 256KBのフラッシュ メモリを内蔵しています。フラッシュ メモリは平均 85%のシングル サイクル SRAMアクセス性能を

実現する読み出し加速装置を備えています。 

12.2 BLEサブシステム 

BLE サブシステムは BLE リンク層エンジンおよび物理層から成ります。リンク層エンジンはマスターとスレーブ両方のロール
に対応しています。リンク層エンジンは、タイム クリティカルなデバイス検出と接続関連の手順、およびハードウェアでの AES

暗号化を実行して、消費電力を削減し、プロセッサ介入を最小限にしながら高性能を実現します。リンク層制御やホスト プロトコル
などの主なプロトコル要素はファームウェアで実装されます。ダイレクト テスト モード (DTM) は、標準 Bluetoothテスタを使用
して無線性能をテストするために含まれてます。物理層はモデムおよび、2.4GHz ISMの周波数帯と 1Mbpsのデータ レート
で BLE パケットを送受信する RF トランシーバーから成ります。送信では、このブロックが GFSK 変調を行った後、これらの
BLE パケットのデジタル ベースバンド信号を無線周波数に変換しアンテナから送信します。受信では、このブロックが GFSK

復調を行った後、アンテナからの RF信号をデジタル ビット ストリームに変換します。 

RF トランシーバーはバランを内蔵し、整合回路を介して 50Ω アンテナを駆動するシングルエンド RF ポート ピンを備えています。 

出力電力は、消費電流を異なるアプリケーション毎に最適化するため、-18 dBm～+3dBmでプログラム可能です。 

BLEプロトコル スタックは以下の機能を実現します。 

 リンク層 (LL) 

 マスターとスレーブのロール 

 128ビットのAES暗号化 

 低デューティ比通知 (Bluetooth 4.1の機能) 

 低エネルギーPing (Bluetooth 4.1の機能) 

 以下のものを備えているBLE 4.1シングル モード ホスト スタック 

 論理リンク制御と適応プロトコル (L2CAP)、アトリビュート (ATT) およびセキュリティ マネージャ (SM) プロトコル 

 一般アトリビュート プロファイル (GATT) と一般アクセス プロファイル (GAP) 

 GATT、GAP、L2CAPへのAPIアクセス 

 L2CAP接続向けチャネル (Bluetooth 4.1の機能) 

 GAP機能 

 ブロードキャスター、オブザーバー、ペリフェラル、セントラルのロールおよび手順 

 セキュリティ モード1: レベル1、2、3 

 セキュリティ モード2: レベル1、2 

 ユーザー定義の通知データ 

 複数の接続に対応 

 GATT機能 

 GATTクライアントとサーバー 

 GATTサブプロシージャに対応 

 32ビットUUID (Bluetooth 4.1の機能) 

 セキュリティ  

 ペアリング方法: Just Works、Passkey Entry、Out of Band 

 認証済みの中間者攻撃 (MITM) 保護とデータ署名 

 BLEプライバシーおよび署名データ 

 すべてのSIG採用BLEプロファイルに対応 

 

サイプレスが提供するソフトウェア (PSoC Creator) により、BLE ソリューションの設計は非常に簡単になります。この GUI

ベースのコンフィギュレーション ツールを使用すれば、BLE プロトコル スタックのロール、機能およびパラメーターを構成でき
ます。詳細については、BLEコンポーネント データシートをご参照ください。 
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12.3 プログラマブルなデジタル ペリフェラル 

PRoC BLEは豊富なデジタルおよびアナログ ペリフェラルを提供します。デジタル ペリフェラルは SCB、TCPWMおよび I2S

を含んでいます。アナログ ペリフェラルは高速 12ビットの逐次比較レジスタ アナログ-デジタル コンバーター (SAR ADC)、静

電容量タッチ センシング (CapSense)、およびセグメント LCD直接駆動を含みます。 

12.3.1 プログラマブルな SCB 

PRoC BLE は 2 個の独立して実行時にプログラマブルな SCB を内蔵しています。これらのブロックは I
2
C、SPI または

UARTインターフェースを備えています。これらの SCBブロックは以下の機能をサポートします。 

 Motorola、Texas Instruments、National Semiconductor のプロトコルと互換性のある標準的な SPI マスターと SPI ス

レーブ機能 

 SmartCard リーダー、ローカル相互接続ネットワーク (LIN)、および赤外線データ協会 (IrDA)プロトコルと互換性のある

標準的な UART機能 

 標準的な I
2
Cマスターおよびスレーブ機能 

 CPUの介入なしに動作が可能な SPI および I
2
Cモード 

 SPIおよび I
2
Cプロトコル用の低電力 (ディープ スリープ) 動作モード (外部クロックを使用) 

詳細については、 SCBコンポーネント データシートをご参照ください。 

12.3.2 プログラマブルな TCPWM/PWM 

PRoC BLEはプログラマブルな 16ビットの TCPWMブロックを持っています。各 TCPWMは、16ビット タイマー、カウンタ、

PWM、または直交デコーダを実装できます。TCPWM は、相補出力および選択可能なスタート、リロード、ストップ、カウント、

およびキャプチャ イベントの信号を提供します。PWMモードは中央揃え、エッジ、および擬似ランダム動作をサポートします。 

詳細については、 TCPWMコンポーネント データシートをご参照ください。 

ファミリの一部のデバイスは TCPWMの他に、4個の追加の PWM を備えています。PWMペリフェラルは 8 ビットまたは 16

ビット分解能で設定できます。PWMには、ハードウェアで単一または連続タイミングと制御信号を生成するために比較出力が

あります。また CPU の介入を最小限にして複雑なリアルタイム イベントを正確に発生させる簡単な方法も提供します。最大 

4個の 8ビット PWMまたは最大 2個の 16ビット PWMがあります。 

詳細については、PWMコンポーネント データシートをご参照ください。 

12.3.3 IC間サウンドバス ブロック  

PRoC BLEはマスター モードで動作し、独立したデータ バイト ストリームを持つトランスミッター (TX) とレシーバー (RX) に

対応する I2S ブロックを内蔵しています。このブロックはサンプル当たり 8～32 データ ビット、および 16、32、48 または 64

ビットワード選択期間をサポートします。データレートは最大 96kHz まで (64 ビットワード選択期間) です。独立型左右チャネル

FIFOまたはインターリーブ型ステレオ FIFOが使用可能です。 

詳細については、 I2Sコンポーネント データシートをご参照ください。 

12.4 設定可能なアナログ ペリフェラル 

12.4.1 ハードウェア シーケンサーを備えた SAR ADC 

PRoC BLEは 12ビット、1Mspsの SAR ADCを内蔵しています。入力 チャネルは、プログラマブルな分解能およびシングル 

エンドまたは差動入力オプションをサポートします。チャネル数は使用可能な GPIO数のみによって制限されます。 

SAR ADCは、CPUの介入無しに最大 8個のチャネルで自動スキャンを実行できるハードウェア シーケンサーを備えていま

す。SAR ADCは、またこれらの 8個のチャネルで出力データの累積や平均化などの前処理動作をサポートします。 

詳細については、逐次比較型コンポーネント データシートをご参照ください。 

12.4.2 静電容量タッチ センシング (CapSense) 

静電容量タッチ センサーは、人体の静電容量を使ってセンサー上またはセンサーの近くの指の存在を検出します。静電容量
センサーは機械式ボタンに比べると、審美的に優れており、使い易く、長寿命のものです。 

http://www.cypress.com/?rID=78826
http://www.cypress.com/?rID=78825
http://www.cypress.com/?docID=45854
http://www.cypress.com/?rID=46464
http://www.cypress.com/?rID=78748
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PRoC BLEの CapSense機能は高い信号対ノイズ比、クラス最高の耐水性を実現し、ボタン、スライダー、トラックパッドや近
接センサーなどの多種多様なセンサーのタイプをサポートします。  

ジェスチャーに対応した CapSense トラックパッドは以下の特長を持っています: 

 1本指と 2本指タッチのアプリケーションに対応 

 最大 35個の X/Yセンサー入力に対応 

 ジェスチャー検出ライブラリを含む: 

 1本指タッチ: トレース、パン、クリック、ダブルクリック 

 2本指タッチ: パン、クリック、ズーム 

サイプレスが提供するソフトウェア コンポーネントを使用すれば、静電容量センシングの設計が簡単になります。本コンポーネント
は、SmartSense™というハードウェア自動チューニング機能をサポートします。 

詳細については、CapSense設計ガイドをご参照ください。 

12.4.3 セグメント LCD直接ドライバー 

血糖値計、マルチメータやリモコンなどのほとんどの低消費電力のポータブルな携帯機器はセグメント LCD を使って情報を

表示します。セグメント LCDはマイクロコントローラと接続するために外部ドライバーを必要とします。PRoC BLEはセグメント

LCDガラスを直接駆動できる低消費電力 LCD ドライバーを内蔵しています。 

PRoC BLE は最大 4 つのコモンラインと 32 セグメント電極を持つ LCD を駆動できます。セグメント LCD ドライバーは、 

ディープ スリープのシステム電力モードで最低 7µAのシステム電流消費量でスタティック ディスプレイを保持できます。 

詳細については、AN87391  PSoC 4セグメント LCD直接駆動をご参照ください。 

12.4.4 プログラマブル GPIO 

PRoC BLE は最大 36 本のプログラマブルな GPIO ピンを備えています。CapSense、LCD、アナログ、またはデジタル信号

用に GPIOを設定できます。PRoC BLEの GPIOは多くの駆動モード、駆動能力およびスルーレートに対応します。 

PRoC BLE は内部信号を GPIO に接続する多様な選択肢を与えるインテリジェントな配線システムを提供します。この柔軟

な配線により、回路設計と基板レイアウトが簡単になります。 

詳細については、PRoC™ BLEテクニカル リファレンス マニュアルをご参照ください。 

12.5 システム全体のリソース  

12.5.1 電源と電圧の監視 

PRoC BLEは 1.9V～5.5V電源電圧で動作できます。さまざまな電力モードをサポートするためのアクティブ デジタル レギュ

レータ、静音レギュレータ、ディープ スリープレギュレータやハイバネート レギュレータなどの多数の内部レギュレータがあります。  

PRoC BLEはパワーオンリセット (POR)、電圧低下検出 (BOD) および低電圧検出 (LVD) の 3種類の電圧監視機能を持っ

ています。  

詳細については、PRoC™ BLEテクニカル リファレンス マニュアルをご参照ください。 

12.5.2 クロック供給システム 

PRoC BLEは以下のクロック ソースを備えています。 

 内部主発振器 (IMO): IMO は PRoC BLE の内部クロック供給の主なソースです。CPU およびすべての高速ペリフェラ

ルは IMOからのクロックで動作します。PRoC BLEは IMOから動作する多数のクロック分周器を含んでいます。これら

の分周器は高速のペリフェラル用のクロックを生成します。 

 内部低速発振器 (ILO): ILOは超低消費電力発振器であり、主にディープ スリープ モードで動作する低速ペリフェラル用

にクロックを生成します。  

 外部水晶発振器 (ECO): ECO は Bluetooth 4.1 仕様で指定された±50ppm クロック精度要件を満たすために BLE 

サブシステムのアクティブ クロックとして使用されます。 ECOは、実際のクロック周波数を測定することで水晶クロック周

波数を調整するための調整可能な負荷コンデンサを備えています。高精度 ECO クロックをシステム クロックとしても使

用できます。 

http://www.cypress.com/?rID=78578&source=an79953
http://www.cypress.com/?rID=86766&source=an79953
http://www.cypress.com/?app=search&searchType=advanced&keyword=&rtID=117&id=4749&an79953
http://www.cypress.com/?app=search&searchType=advanced&keyword=&rtID=117&id=4749&an79953
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 時計用水晶発振器 (WCO): WCOは Bluetooth 4.1仕様で指定された±500ppmクロック精度要件を満たすために BLE

サブシステムのスリープ クロックとして使用されます。スリープ クロックは正確なスリープ タイミングを提供し、指定された

通知と接続間隔でのウェイクアップを可能にします。WCO およびファームウェアにより、正確なリアルタイム クロック 

(32.768kHz水晶発振器の精度範囲以内) は実現できます。 

図 66に、PRoC BLEデバイスのクロッキング アーキテクチャを示しています。詳細については、PRoC™ BLEテクニカル リ

ファレンス マニュアルをご参照ください。 

図 66 PRoC BLEクロック供給システム 
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12.5.3 低消費電力モード 

PRoC BLEは表 3に示すように以下の 5つの電力モードをサポートします。  

注: これらのモードは PRoC BLEデバイスの電力モードであり、BLEサブシステムで記述される電力モードと異なります。  

 アクティブ モード: これは主要な動作モードです。このモードでは、すべてのペリフェラルが有効です。 

 スリープ モード: このモードでは、CPU がスリープ状態になり、SRAM が保持状態になり、すべてのペリフェラルが有効

です。割り込みが発生すると、CPUがウェイクアップして、システムがアクティブ モードに戻ります。 

 ディープ スリープ モード: このモードでは、高周波数クロック (IMO) およびすべての高速ペリフェラルが無効です。WDT、

LCD、I
2
C/SPI、リンク層および低周波数クロック (32kHz ILO) は有効です。GPIO、WDTまたは SCBからの割り込みは、

ディープスリープになったコンポーネントをウェイクアップさせることができます。このモードでは、PRoC BLE ファミリのす

べてのデバイスの電流消費量は 1.3µAです。 

 ハイバネート モード: この電力モードは、SRAM、プログラム可能な論理、および GPIO から生成された割り込みにより

ウェイクアップする機能を保持しながら、150nAというクラス最高の電流消費量を実現します。 

 ストップ モード: この電力モードでは GPIO状態が保持されます。固定の「WAKEUP」ピンからのウェイクアップは可能で

す。このモードでは、電流消費量は 60nAのみです。 

http://www.cypress.com/?app=search&searchType=advanced&keyword=&rtID=117&id=4749&an79953
http://www.cypress.com/?app=search&searchType=advanced&keyword=&rtID=117&id=4749&an79953
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表 3. PRoC BLE低消費電力モード 

BLESSモード 

PRoC BLEシステム電力モード 

アクティブ スリープ ディープスリープ ハイバネート ストップ 

送信      

受信      

アイドル      

スリープ      

ディープスリープ      

パワー      

 

12.5.4 デバイス セキュリティ 

PRoC BLE はフラッシュ メモリを不正アクセスあるいはコピーから保護するオプションをいくつか提供します。 フラッシュの各行に 1 つ

の保護ビットがあります。これらのビットは監視フラッシュ行に格納されています。 

12.6 プログラマブル GPIO 

I/O システムは CPU やペリフェラルと外部間のインターフェースを提供します。PRoC BLE は最大 36 本のプログラマブルな GPIO 

ピンを備えています。CapSense、LCD、アナログ、またはデジタル信号用に GPIO を設定できます。PRoC BLE の GPIO は多くの駆

動モード、駆動能力およびスルーレートに対応します。 

PRoC BLE は内部信号を GPIO に接続する多様な選択肢を与えるインテリジェントな配線システムを提供します。この柔軟な配線 

により、回路設計と基板レイアウトが簡単になります。 
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13 付録 E: BLEプロトコル 

13.1 概要 

BLE (Bluetooth Smart とも呼ばれている) は 2.4GHz ISM 帯で動作する低消費電力の無線標準として Bluetooth SIG により 

策定されました。図 67に BLEスタックを示しています。 

図 67. BLEアーキテクチャ 
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BLEスタックは次の 3グループに分けられます。 

 コントローラー: 物理デバイスで、パケットを暗号化して無線信号として送信します。信号の受信時にこのコントローラーは

無線信号を復号してパケットを復元します。 

 ホスト: セキュリティ マネージャ、アトリビュート プロトコルなどの様々なプロトコルとプロファイルを含むソフトウェア スタック 

であり、2つ以上のデバイスがどのように他のデバイスに通信するかを管理します。 

 アプリケーション: ソフトウェア スタックとコントローラーを使用して特定の機能を実装する使用例です。 

下記の節は、一般的な心拍数監視サービスと電池通知サービスを例として取り上げて BLE スタックの複数の層の概要につ

いて説明します。BLE アーキテクチャの詳細説明については、Bluetooth Developer のサイトに搭載されている Bluetooth 

4.1仕様または学習ビデオをご覧ください。 

13.2 物理層 (Physical Layer；PHY) 

この層は、2.4GHz ISM帯のガウス型周波数偏移変調 (GFSK) という変調方式を利用して 1Mbpsでデジタル データを送受

信します。この BLEの物理層は ISM帯を 2MHz ごと 40個の RF チャネルに分けており、その内データチャネルは 37個で

宣伝チャネルは 3個です。 

13.3 リンク層 (Link Layer；LL) 

この層では、 (認識およびフロー制御に基づいたアーキテクチャを利用して) 信頼性のある物理リンクを成立するための重要

な手続き、および堅牢で低消費電力の BLEプロトコルを実現する機能を実装します。以下はリンク層の機能の一部です。 

https://developer.bluetooth.org/Pages/default.aspx
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 アドバタイジング (宣伝) 、スキャンニング、接続の作成および維持: 物理リンクを確立できます。 

 24ビット CRCおよび 128ビット AES暗号化: データ交換時の堅牢性と安定さを確保できます。 

 高速接続の確立および低デューティ比の宣伝: 低消費電力動作を実現できます。 

 AFH (Adaptive Frequency Hopping): パッケト送信用の通信チャネルを変更し他のデバイスからの干渉を軽減できます。 

リンク層では、次の 2つのロールが定義されます。  

 マスター: スマートフォンはリンク層をマスターに設定する例です。  

 スレーブ: 心拍数監視機器はリンク層をスレーブに設定する例です。  

PSoC／PRoC BLEデバイスは両方の設定で動作できます。  

リンク層スレーブは自体の存在を他のリンク層マスターに宣伝するものです。リンク層マスターは宣伝パケットを受信し、アプリ

ケーションの要求に応じてスレーブとの接続を決定します (図 68をご覧ください) 。この心拍数監視アプリケーションの実装例

では、心拍数監視機器はスレーブとして動作し、データをマスターとしてのスマートフォンに送信します。スマートフォンのアプリ

ケーションはその後スマートフォン上に読み出し結果を表示します。  

PSoC／PRoC BLEデバイスは、宣伝、CRCや AES暗号化方式などタイム クリティカルでプロセッサが集中するリンク層の機能

をハードウェアで実装します。宣伝状態に移行するか暗号化を開始するなどのリンク層制御動作はファームウェアで実装されます。 

図 68に、BLEのリンク層パケットの構造およびリンク層パケット内の各フィールドのサイズを示しています。リンク層パケットは

すべての上位層のデータを自体のペイロード フィールドに格納します。物理リンク上の通信を識別し同じ RF チャネルで動作

する近隣 BLE デバイスからのパケットを無視するために 4バイトのアクセス アドレスを用意します。24ビット CRCによりデータの

堅牢性を確保できます。 

図 68. BLEリンク層プロトコル 
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13.4 ホスト制御インターフェース (Host Control Interface；HCI) 

HCI はホストとコントローラー間の標準として定義されたインターフェースです。これによりホストとコントローラーがコマンド、

データ、イベントなどの情報を USB や UART のような異なる物理的転送方式で相互交換できます。コントローラーとホストは

異なるデバイスの場合にのみ HCIに物理的転送方法を整備する必要があります。  

PSoC／PRoC BLEデバイスでは、HCIが単なるファームウェア プロトコル層で、メッセージとイベントをコントローラーとホスト間に

転送するだけです。 

13.5 論理リンク制御および適応プロトコル (Logical Link Control and Adaptation Protocol；L2CAP) 

L2CAP はプロトコルの多重化、分割、再構成サービスを上位プロトコルに提供します。分割サービスでは、上位層から受信 

したパケットをリンク層が送信できる多くのより小さいパケットに分けますが、再構成サービスでは、リンク層から受信した分割

済みより小さいパケットを組み合わせして有意味のパケットを構成します。L2CAP層は、図 69のように、アトリビュート プロト

コル (Attribute Protocol；ATT)、セキュリティ マネージャ (Security Manager；SM)、および L2CAP自体の制御用に 3つのプ

ロトコル チャネル ID を提供します。Bluetooth 4.1仕様により、これらのプロトコル チャネルの最上位にある L2CAP接続指

向チャネルから直接接続データ チャネルを作成できます。 

PSoC／PRoC BLEでは L2CAPとそれにある各層がファームウェアで実装されます。 
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図 69. BLE L2CAPの層 

- Connection Timing 

Update

- Command Reject etc. 

- Read Attribute Request

- Read Attribute Response 

etc. 

L2CAP Control

ATTRIBUTE PROTOCOL (ATT)

L2CAP 

L2CAP

- Encryption Information

- Security Request etc. 
SECURITY MANAGER (SM)

Preamble Access Address
Protocol Data Unit (PDU) CRC

(x24+x10+x9+x6+x4+x3+x1+x0)Header 

  (1B)

Payload 

Length (1B)
Payload

Connection Oriented 

L2CAP Channel CommandAPPLICATION

Link Layer

Physical Layer

ATT 
Commands

SM Commands

Application Data and Commands

 

 

13.6 セキュリティ マネージャ (Security Manager；SM) 

SM層はペアリング、暗号化、および鍵の配布用の方法を定義します。 

 ペアリングはセキュリティ機能を有効にするプロセスです。このプロセスでは、2 つのデバイスが認証され、そのリンクが

暗号化されてから、暗号化の鍵が交換されます。これにより、RF チャネル上でスパイにより探られることなく、BLE

インターフェースを介してデータが安全に交換できるようになります。 

 ボンディングは、ペアリング プロセスで交換された鍵と識別情報が保存されるプロセスです。デバイスが一度 

ボンディングされたら、再接続する際に再度ペアリング プロセスを経過する必要がありません。 

 BLEはデータ暗号化に 128ビット AES方式を用いています。  

13.7 アトリビュート プロトコル (Attribute Protocol；ATT) 

BLEの GATT仕様には、ATTと GATT層を理解するために把握する必要がある 2つのロールがあります。  

 GATTサーバー: データや情報を格納します。GATTクライアントから要求を受信しデータで返答します。例えば、心

拍数監視の GATT サーバーは心拍数の情報を格納します。BLE 型 HID キーボードの GATT サーバーはユーザ

がキーを押す情報を格納します。 

 GATT クライアント: GATT サーバーからデータを要求／受信します。例えば、スマートフォンは GATT サーバーから 

心拍数情報を受信する GATT クライアントです。ノートパソコンは BLE キーボードからキー押下情報を受信する

GATTクライアントです。 

ATT は BLE 通信の基盤となります。このプロトコルにより GATT クライアントが GATT サーバーでデータやアトリビュートを

検索してアクセスすることが可能になります。GATT クライアントと GATTサーバーのアーキテクチャの詳細については、一般

的アトリビュート プロファイル (Generic Attribute Profile；GATT) をご参照ください。  

アトリビュートは次の内容を含む ATT/GATT層の基本的なデータ コンテナです。  

 アトリビュート ハンドル: 1つのアトリビュートをアドレス指定してそれにアクセスする 16ビット アドレスです。 

 アトリビュート タイプ: アトリビュートに格納されるデータの種類を指定します。Bluetooth SIG が定義した 16 ビット

UUIDで表示されます。 

例えば、心拍数管理サービスの 16ビット UUIDは 0x180Dで、デバイス名アトリビュートの UUIDは 0x2A00です。SIGが指

定した 16ビット UUIDの一覧については Bluetoothのホームページをアクセスしてご参照ください。 

http://en.wikipedia.org/wiki/Advanced_Encryption_Standard
https://www.bluetooth.org/en-us/specification/assigned-numbers
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 アトリビュート バリュー: アトリビュートに格納される実際の値です。 

 アトリビュート パーミッション: アトリビュート アクセス、認証、および権限の要件を指定します。これはより上位層の

仕様により設定され、アトリビュート プロトコルを通してアクセスできません。 

図 70にデバイス名アトリビュートの構造を例として取り上げます。 

図 70. アトリビュート フォーマットの例 
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13.7.1 アトリビュート階層  

アトリビュートはデータを表示する ATT/GATT 層での構成要素です。アトリビュートは大きく次の 2 グループに分けられ、データ 

階層とデータ抽象化を提供します。 

 キャラクタリスティック: アトリビュートのコレクションであり、システム情報や有意味のデータを表します。1 つのキャラクタ

リスティックは次のアトリビュートからなります。 

 キャラクタリスティック宣言アトリビュート: キャラクタリスティックの開始を定義します。 

 キャラクタリスティック バリュー アトリビュート: 実際のデータを格納します。 

 キャラクタリスティック ディスクリプタ アトリビュート: これらは任意のアトリビュートであり、キャラクタリスティック値の追

加情報を提供します。 

「電池レベル」は電池通知サービス (BAS) のキャラクタリスティックの 1 つの例です。電池レベルをパーセント値で表示する

のはキャラクタリスティック ディスクリプタの 1つの例です。 

図 71に例として電池レベルのキャラクタリスティックの構造を示しています。  

 キャラクタリスティックの最初の部分はそのキャラクタリスティックの宣言 (キャラクタリスティックの開始を示す) であり、

図 71の例に「電池レベル キャラクタリスティック」として表示されています。  

 次は実際のキャラクタリスティック値または実際の値であり、例の電池レベル キャラクタリスティックでは当時の電池 

レベルです。電池レベルは「65」、「90」など全測定範囲に対する割合 (パーセント) で表示されます。  

 キャラクタリスティック ディスクリプタはキャラクタリスティックの値の意味を解明するのに必要な追加情報を提供します。 

例えば、電池レベルの表示形式のキャラクタリスティック ディスクリプタは電池レベルがパーセントで表示されることを
示します。よって、「90」が読み出されると、GATT クライアントは 90mV や 90mAh ではなく 90%と理解します。 

同様に、(図 71 に表示されない) 有効範囲のキャラクタリスティック ディスクリプタは電池レベルの範囲が 0～100 

パーセントであることを示します。 

 クライアント キャラクタリスティック コンフィギュレーション ディスクリプタ (CCCD) は別の一般的なキャラクタリスティック  

ディスクリプタであり、GATT クライアントによる GATT サーバー上のキャラクタリスティックの動作設定を可能にする
ものです。GATT クライアントが 0x01 の値を任意のキャラクタリスティックの CCCD に書き込むと、(後節で説明する
ように) GATT サーバーからの通知が非同期に送信されます。電池レベル キャラクタリスティックの場合は、電池 

レベル CCCD に 0x01 の値を書き込むと、電池通知サービスが自体の電池レベルを定期的または電池レベルの変
更時に通知することが可能になります。 
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図 71. キャラクタリスティックのフォーマットと例 
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 サービス: GATT サーバーが実行する機能を定義するアトリビュートの一種です。サービスはキャラクタリスティックの 

コレクションであり、他のサービスを含むこともあります。サービスの概念は関連するデータ グループを設立し、データ階

層を提供するのに使用されます。心拍数管理サービス (HRS) の例は図 72をご覧ください。 

サービスは一次サービスと二次サービスの 2 種類に分けられています。一次サービスはデバイスの主な機能を提供し、

二次サービスは追加機能を提供します。例えば、心拍数監視デバイスの場合には、HRS は一次サービスで、BAS は二次 

サービスです。 

サービスは GATT サーバーにある他のサービスも含むことがあります。含まれているすべてのサービスは新しいサービスの

一部になります。 

図 72. BLE心拍数サービスの例 
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BLE の「プロファイル」という言葉は特定のエンド アプリケーションを共に実現するサービスとその動作のコレクションです。 

心拍数プロファイル (HRP) は BLE プロファイルの例で、心拍数監視デバイスの作成に必要なすべてのサービスを定義しま

す。詳細については一般的アクセス プロファイル (Generic Access Profile；GAP) 節をご覧ください。 

図 73 には、本節の上記に定義されたアトリビュート、キャラクタリスティック、サービス、およびプロファイルを使用するデータ

階層を示しています。 

https://www.bluetooth.org/docman/handlers/downloaddoc.ashx?doc_id=239866
https://www.bluetooth.org/docman/handlers/downloaddoc.ashx?doc_id=239865
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図 73. BLEデータ階層* 

 

*Bluetooth SIGからの無料イメージ 

13.7.2 アトリビュート動作  

前節で定義したアトリビュートは次の 5つの基本的な方法でアクセスされます。  

 読み出し要求: GATTクライアントはアトリビュート バリューの読み出しのためにこの要求を GATTサーバーに送信します。

各要求ごとに GATT サーバーは GATT クライアントに応答を送信します。この読み出し要求の例は、スマートフォンが 

心拍数監視デバイスの電池レベル キャラクタリスティックを読み出すことです (図 71をご覧ください) 。 

 書き込み要求: GATTクライアントはアトリビュート バリューの書き込みのためにこの要求を GATTサーバーに送信します。

GATT サーバーはその値が書き込んだか否かを GATT クライアントに返答します。書き込み要求の例はスマートフォンが

0x01の値を電池レベル キャラクタリスティック CCCDに書き込んで通知を有効にすることです。 

 書き込みコマンド: GATTクライアントはアトリビュート バリューの書き込みのためにこのコマンドを GATTサーバーに送信

します。このコマンドに対して GATT サーバーは何の返答も送信しません。例えば、BLE即時アラート サービス (IAS) は 

(スマートフォンなどの) IAS 検知器から (LED をオンにする、ブザーを鳴らす、振動モーターを駆動することなどの) アラートを 

(BLEキーフォブなどの) 対象の IASデバイス上でトリガーするために書き込みコマンドを使用します。 

 通知: GATT サーバーはあるアトリビュートの新しい値を通知するためにこの通知を GATT クライアントに送信します。

GATT クライアントはこの通知に対して何の確認も送信しません。例えば、心拍数監視デバイスはその CCCDに 0x01が

書き込まれると心拍数測定通知をスマートフォンに送信します。 

 指示: GATT サーバーはこの種類のメッセージを送信します。GATT クライアントは常にその確認を行います。例えば、

BLE健康体温計サービス (HTS) は測定した体温の値を、スマートフォンのような健康体温計コレクターに確実に送信する

ためにこれらの指示を使用します。 

 

 

 

 

 

 

https://developer.bluetooth.org/gatt/services/Pages/ServiceViewer.aspx?u=org.bluetooth.service.immediate_alert.xml
https://developer.bluetooth.org/gatt/services/Pages/ServiceViewer.aspx?u=org.bluetooth.service.health_thermometer.xml
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13.8 一般的アトリビュート プロファイル (Generic Attribute Profile；GATT) 

GATTはアトリビュートの検出と使用方法を定義します。GATTは次の 2つのロールのいずれかで動作します。 

 GATT クライアント: データを要求するデバイス (例えば、スマートフォン) です。 

 GATTサーバー: データを提供するデバイス (例えば、心拍数モニター) です。 

図 74 には心拍数監視デバイスを例として GATT 層内のクライアントとサーバーのアーキテクチャを示しています。心拍数監

視デバイスは多くのサービス (HRS、BAS、およびデバイス情報サービス) を提供し、それぞれのサービスは図 71に示すよう

にキャラクタリスティック値とキャラクタリスティック ディスクリプタを含む 1つ以上のキャラクタリスティックを持っています。 

図 74. GATTクライアントとサーバーのアーキテクチャ 

GATT Client

(Smartphone)

GATT Server

(Heart Rate Sensor)

Device Info 

Service

Serial Number

Heart Rate 

Service

Heart Rate
Requests

Responses

Battery Level 

Service

Battery Level

FW Version

Sensor Location

 

BLE接続がリンク層レベルで確立された後、 (接続された BLEデバイスについて最初に何も分からない) GATT クライアント

は「サービス発見」というプロセスを開始します。サービス発見の一部として、GATT サーバーでの全ての有効なサービス、 

キャラクタリスティック、アトリビュート一覧を得るために GATT クライアントは GATT サーバー側に多くの要求を送信します。

サービス発見が完了した後、GATT クライアントは、前述したアトリビュート動作を利用することで GATTサーバーが提供する

情報の読み出しや修正に必要な情報を得ました。 

13.9 一般的アクセス プロファイル (Generic Access Profile；GAP) 

GAP層はデバイス アドレス、デバイス名などのデバイス固有の情報、および発見／接続／接着 (ボンディング) 方法を提供し

ます。このプロファイルは、デバイスの発見／接続方法、使用可能なサービス一覧、およびサービスの使用方法を定義します。

図 76に心拍数プロファイルの例を示します。 

GAP層は次の 4つのロールのいずれかで動作します。  

 ペリフェラル: デバイスを GAP セントラルに接続することを可能にする宣伝のロールです。セントラルとの接続が確立さ

れた後、デバイスはスレーブとして動作します。例えば、遠隔装置に測定した心拍数を報告する心拍数センサーは GAP

ペリフェラルとして動作します。 

 セントラル: 宣伝をスキャンしてペリフェラルとの接続を開始する GAP ロールです。この GAP ロールはペリフェラルとの

接続が確立した後、マスターとして動作します。例えば、ペリフェラル (心拍数センサー) から心拍数計測データを受信し

たスマートフォンは GAPセントラルとして動作します。  

 ブロードキャスター: データを放送するのに使用される宣伝ロールです。BLE 接続を確立できず、データ交換にも関与し

ません (要求／応答動作がありません)。このロールは、聞き手が有無かを問わずデータを連続して送信するラジオ放送

局と同様の役割を果たしている一方向データ通信です。何の応答も求めなく情報を連続して放送するビーコンは GAP 

ブロードキャスターの典型的な例です。 

 オブザーバー: 宣伝をスキャンしますが宣伝デバイスとの接続を実現しない聞き取りロールです。これはブロードキャス 

ター ロールの逆のロールです。情報を連続して聞き取るが、情報源に通信できないラジオ受信機と同様に動作します。

ビーコンからの信号を連続的に聞き取るスマートフォン アプリケーションは GAP オブザーバーの典型的な例として取り

上げられます。 
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図 75に、サイプレスの BLE Pioneer Kitがペリフェラルでスマートフォンがセントラル デバイスである一般的な BLEシステム

を示します。また、BLE プロトコルの層間の相互作用、およびセントラルとペリフェラル デバイス上に該当するロールも示して

います。 

図 75. BLEシステムの設計 

 

  

図 76に、心拍数アプリケーションを内蔵するスマートフォンがセントラルとして動作し、心拍数センサーがペリフェラルとして動

作する例を示します。心拍数監視デバイスは心拍数センサー プロファイルを実装し、データを受信するスマートフォンは心拍

数コレクター プロファイルを実装します。  

この例には、心拍数センサー プロファイルは次の 2 つの標準サービスを実装します。一つ目は心拍数サービスで、3 つの 

キャラクタリスティック (心拍数計測キャラクタリスティック、身体センサー位置キャラクタリスティック、および心拍数制御点 

キャラクタリスティック) からなります。第 2 のサービスはデバイス情報サービスです。リンク層では、心拍数計測デバイスが 

スレーブで、スマートフォンがマスターです。心拍数のサービスとプロファイルの詳細については Bluetooth developer portal

サイトにアクセスしてご覧ください。 

https://www.bluetooth.org/docman/handlers/downloaddoc.ashx?doc_id=239866
https://www.bluetooth.org/docman/handlers/downloaddoc.ashx?doc_id=239865
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図 76. BLE心拍数監視システム 
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